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Accessible PDF Documents with 
Adobe Acrobat 9

Application
Adobe Acrobat 9 Professional
http://www.adobe.com/products/acrobatpro/

Terminology
Accessible
Content and/or materials that are functional and usable to individuals with dis-
abilities.  With respect to this document, “accessible” and “accessibility” do not 
relate to the availability of the materials, but rather if it is functional/usable to 
individuals with disabilities.

Assistive computer technology
Computer applications that improve the experience for individuals with dis-
abilities to use, maintain, interact, or develop computer-based content.  Assis-
tive computer technologies compose a broad spectrum of applications that can 
include speech recognition, screen-enlargement/magnification, screen-readers, 
etc.

Screen-reader
A screen-reader is a type of assistive computer technology used by individuals 
who are blind or visually-impaired.  A screen-reader “reads” the information on 
the screen to the user, who can control the on-screen focus by various keyboard 
commands.

Speech recognition
Speech recognition is a type of assistive computer technology commonly used 
by individuals who have a mobility impairment or repetitive stress injury.  The 
individual speaks commands or dictation into a microphone, whereby the 
speech recognition system carries out the command or enters the spoken text.

Text-to-Speech
Text-to-speech technology allows for the communication of text-based informa-
tion into audible speech.  Text-to-speech technology is a core element within 
screen-reader applications, but may also be used separately by non-disabled 
individuals who wish to listen as opposed to visually interacting with content.

Introduction
Adobe Acrobat provides users with the capability of manipulating, enhancing, 
and securing PDF documents.  With respect to accessibility, Adobe Acrobat 
includes several tools and options that allow for the creation of accessible PDF 



documents from word processing applications (e.g., Microsoft Office, etc.)  as 
well as adding accessibility information to existing PDF documents.  Adobe 
Acrobat 9 now provides improvements to zoning and marking text, adding rel-
evant accessibility information to data tables, and adding tags to existing PDF 
documents.  

Word Processing Applications
Creating accessible PDF documents from word processing applications requires 
that content authors include the relevant accessibility information during the 
document authoring process.  Upon conversion to a PDF version of the docu-
ment, the appropriate accessibility information is then added to the file and can 
be utilized by assistive computer technologies.  This is often the easiest method 
for insuring access is provided in the PDF version of the document.  For most 
documents with accessibility integrated into the authoring workflow, the author 
will not be required to examine the PDF document separately to make any addi-
tional accessibility improvements.

Documents that are visually rich in formatting and layout, however, may require 
the use of specialized layout and design programs as opposed to word pro-
cessing applications.  While it is possible to accomplish some basic layout and 
formatting in word processing applications, these documents do not always 
result in accessible PDF versions automatically.  If using word processing appli-
cations to visually layout and design document content, it will be necessary to 
assess the PDF version of the document for any accessibility errors.

Creating Tagged PDFs

PDF documents that support accessibility may be sometimes called “tagged“ 
PDFs.  The presence of PDF tags does not automatically mean the PDF docu-
ment is accessible but it does offer the capability of being accessible.  Several 
PDF creation applications can use the accessibility information included into 
the document authoring application (e.g., Microsoft Word) and represent this 
information as part of a tagged PDF document.  A PDF creation tool that creates 
tagged PDFs provides an opportunity for creating accessible PDF documents.

The following applications can create tagged PDF documents:
1. Microsoft Office 2007 with Microsoft Save As PDF plug-in

2. Microsoft Office 2007 with Adobe Acrobat

3. Microsoft Office 2003 with Adobe Acrobat

4. Open Office (Mac and Windows)

5. Corel WordPerfect X4

6. Adobe InDesign, Framemaker, LiveCycle Designer
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Document Authoring Strategies
Headings

Where appropriate, headings should be used to differentiate between sec-
tions of text.  For example, the title or name of the document may be classi-
fied as a Heading 1, whereas a subsequent section header may be classified as 
a Heading 2.  Adding headings results in a structured document that provides 
several advantages to users.  Individuals using assistive computer technology 
(e.g., screen-readers), would be able to “jump” from heading to heading in the 
document as opposed to listening to every single passage of text in order to get 
to the desired content.  Similar to a visual user “scanning” the content for the 
desired information, the use of headings in a document improves accessibility 
by allowing for non-linear navigation.

The figure below shows the Styles menu in Microsoft Word 2007 (under the 
Home ribbon).  Headings may be applied by selecting the text content and then 
applying one of the heading styles.  For additional Styles and options, press the 
arrow button in the lower right corner of the Styles menu.

Images

Images provide an opportunity to communicate information in a non-verbal 
manner.  For individuals who are unable to see or visually process such images, 
this can be a barrier to interacting with the document content.  Adding a text 
description to images is one method to improving the accessibility of the docu-
ment content such that all users can interact with the materials.  One chal-
lenge with providing a text description for images is what information should 
be included so as to communicate the relevant content and/or purpose of the 
image.  Two resources that can provide guidance and direction to creating 
usable image descriptions can be found at:

Text Alternatives for Images
http://jimthatcher.com/webcourse2.htm

Creating Accessible Images
http://www.webaim.org/techniques/images/



To add alternate text for an image in Microsoft Word 2007, select the image and 
perform a right mouse button click.  Choose the Size option to open the Size 
dialog window.  In the Alt Text tab, add the appropriate text description for the 
image.  The following figure depicts the Alt Text tab with text describing an 
image in a Word 2007 document.

Data Tables

Tables are used for two basic purposes in word processing applications: for 
laying out a visual design and for displaying data.  Using tables to perform 
visual layout and design functions is not recommended and can lead to access 
challenges by assistive technologies.  If there is a need to organize the informa-
tion in a specific spatial arrangement, consider using a layout and design tool 
(e.g., InDesign, Publisher, etc.) as opposed to a word processor.

Using tables to display data, on the other hand, is entirely appropriate and 
allows for greater access by assistive technologies.  Additionally, using tables 
for data allows for content to be more easily converted into alternate formats 
while retaining the relationships among the data points.  In order to improve the 
accessibility of data tables for assistive technologies, it is often necessary to add 
specific code that programmatically identifies the column and row header cells 
of the data table.  Not all word processing applications allow for this function-
ality and subsequent code additions may be required after the document has 
been converted to the PDF version.
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In Microsoft Word 2007, it is possible to add the specific code that program-
matically identifies the column headers in a data table.  For a simple data table, 
this may be the data in the first row (i.e., these cells represent the columns for 
the remainder of the table).  The figure below shows a data table with the first 
row consisting of the following column headers: Spring, Summer, Autumn, and 
Winter.

To programmatically identify the column headers, select the first row and per-
form a right-mouse button click.  Choose the Table Properties option from the 
context menu and select the Row tab.  Check the checkbox marked “Repeat as 
Header Row at the Top of Each Page”.  The figure below shows the Row tab 
and the appropriate checkbox to select.

Once the document is converted to a PDF using either Adobe Acrobat or the 
Save As PDF option, the data table will be constructed with the appropriate 
code to identify the column headings for assistive technologies.  It is not cur-
rently possible to add the appropriate code to designate the row headers in 
Microsoft Word.  Using Adobe Acrobat, it is possible to specify the row header 
information in the PDF version of the document.



PDF Accessibility with Acrobat 9
Documents created from word processing applications, layout and design pro-
grams, or other applications that do not create tagged PDF versions, will require 
additional review and editing of the PDF version in Adobe Acrobat.  The addi-
tional time to review and include accessibility information into the PDF version 
is dependent on a variety of factors, including the application used to create the 
PDF, the visual formatting and layout complexity of the document itself, and/
or the presence of any interactive features in the PDF version.  It is generally 
easier to utilize an authoring application that supports the generation of tagged 
PDF documents and add accessibility information as part of the document 
authoring workflow as opposed to making accessibility changes within the PDF 
document.  However, if the original document is not available or the authoring 
tool does not support the generation of a tagged PDF with accessibility infor-
mation, then it is possible to use Adobe Acrobat to address most accessibility 
issues in the PDF document.

Basic Workflow - AARP
PDF documents that are not tagged are not necessarily inaccessible.  However, 
if there are any accessibility changes that are needed by the document  (e.g., 
change reading order, identify  content headings, add descriptions to images, 
etc.), then it is necessary to add tags to the PDF document.  The following is a 
sample workflow to consider when addressing PDF accessibility:

1. Add Tags to the PDF

2. Assess Logical Reading Order

3. Repair Content where necessary.

4. Perform Assessment process again

Note - Remember, it is generally easier to use a program that supports the cre-
ation of a tagged PDF with accessibility information as opposed to fixing all 
accessibility issues within Adobe Acrobat.

After assessing the logical reading order of the document, the author can utilize 
the tools available in Adobe Acrobat to manipulate the reading order of text, add 
or remove content from the reading order, add descriptions to images, reclas-
sify headings, and add accessibility information to data tables.  After making 
the appropriate accessibility modifications to the PDF document, save the PDF 
file and perform the assessment process again to verify the changes are cor-
rect.  This is just one sample workflow that can be used to assess and correct 
the accessibility of PDF documents, and should be modified depending on the 
needs and organization of the institution.

Adding Tags to a PDF

A tagged PDF document assists accessibility by providing a mechanism to 
specify a logical content order.  Adding tags to a document allows for additional 
accessibility retrofitting and content manipulation to occur.
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1. Check to ensure the PDF document is not already tagged by checking the 
document properties (File > Properties) or the Tags panel (View > Navi-
gation Panels > Tags).

2. Choose Advanced from the menu bar.

3. Choose Accessibility > Add Tags to Document.  This may take a few min-
utes depending on the document size.

4. Once tags have been added to the PDF, save a copy of the document to 
retain the changes.

Assessing Reading Order

One the challenges to PDF document accessibility is the presentation of infor-
mation to the user, or more specifically, the logical order in which the infor-
mation is presented.  It is not enough that the content can simply be read by 
assistive computer technologies; rather, the focus should be on what order the 
information is communicated to the user.  For example, let a PDF document 
have two columns of text.  Using a screen-reader is one method to assess the 
logical reading order of the document and the intent would be to verify that the 
text in the first column is read before the text in the second column.  If the indi-
vidual using the screen-reader is not aware of differences between the spoken 
text versus the on-screen text, it is possible that the individual would mistake 
the reading of any text as an indication that the document has readable content.  
It is necessary for the individual to distinguish between the capability of the 
assistive computer technology to communicate the text information as opposed 
to communicating the text information in its proper reading order.

Use Assistive Computer Technology

There are a number of different assistive computer technologies that could be 
used to review the logical reading order of a PDF document.  However, this 
does make the assumption that the document author has both the assistive 
computer technologies installed and configured on their computer as well as 
the skills to use such applications for review.  Assistive computer technologies 
may include screen-readers (e.g., Jaws for Windows, Window-Eyes, Supernova, 
etc.), reading systems (e.g., Read and Write Gold, etc.) or other text-to-speech 
applications.

Use Adobe Read Out Loud

This is a feature that is part of Adobe Acrobat as well as Adobe Reader.  It will 
process one page at a time and, depending on the length of the document, may 
take a long time to speak the document contents.  The Read Out Loud tool can 
be found under View > Read Out Loud.  Once you have activated the Read Out 
Loud feature, move to the document content to review and choose “Read this 
Page” or “Read to End of Document”.



Save As Text (Accessible)

Another method that can be used to assess the reading order of a PDF document is to 
save the document as a different file type.  This will export the text content of the PDF 
document such that a visual review of the logical reading order may be performed.  
Instead of “listening” to the document content, this allows an author to visually scan the 
resulting text file and see if there are any inconsistencies in how the information would 
be presented auditorily to the user.

1. Choose “File” on the menu bar and select “Export”.

2. Choose “Text” and then “Text (Accessible)”.

3. Specify where you wish to save the resulting text file.

4. Open the text file and review the document content flow.  This provides a close 
visual approximation as to what an individual using assistive computer tech-
nology would hear.

5. Review the text file and PDF document and make the appropriate changes where 
necessary.

Repairing Content

Controlling Reading Order

After adding tags to a PDF document, it is important to verify if the reading order of 
the document follows a logical progression.  This is particularly true if the document 
contains multi-column layouts, sidebars, footnotes or other content areas that deviate 
from the general page layout.  After adding tags to a PDF, enable the Order panel (View 
> Navigation Tabs > Order Panel) to view each page’s reading order.  Reading order 
is determined on a page-by-page basis.  Content on the page will be “zoned” in gray 
boxes with a numerical value in the upper left corner of each “zone”.  These numerical 
values and “zones” in the PDF view are the same as those identified in the Order panel.
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1. To manipulate the reading order, open the Order panel (View > Naviga-
tion Tabs > Order Panel).

2. Click on the box to the left of the numbered content you wish to reorder.  
Move the selected content higher or lower in the Order panel hierarchy.

3. Content should be read in the numerical order in which it appears in the 
Order panel.

You may encounter situations where the tagging process was unable to dis-
tinguish between multiple columns or other page layout designs.  As a result, 
content may become intermixed resulting in an illogical reading order.  It may 
be necessary to first separate out content areas into distinct zones (e.g., create 
multiple zones from one large zone) before altering the reading order.  While 
this does increase the number of zones on the page, this will allow the author 
more control over the actual reading order of the document.

Zoning and Marking Text

After running the Add Tags to Document function, it may be necessary to 
manually modify the document’s reading order.  For example, a two-column 
document may be recognized incorrectly as one single content zone when in 
fact it is actually two separate content zones.  Additionally, information that 
may be relevant to the page content may not have been recognized during the 
tagging process, resulting in relevant content that is not part of the document’s 
logical reading order.  It is also possible that content was added to the document 
reading order, when in fact it does not belong.

Adobe Acrobat’s TouchUp Reading Order tool allows authors to manually 
zone page content and either add or remove this information to the document’s 
reading order.  The TouchUp Reading Order tool also allows authors to clas-
sify content as various heading levels (i.e., Heading 1, Heading 2, Heading 3) 
as well as Figures, Tables, or other structural markup.  Content that does not 
belong as part of the document’s reading order can be marked as “Background”.  
Be cautious of this option as it will result in content be removed from the docu-
ment reading order and not communicated to the end-user.

1. To zone and mark text, enable the TouchUp Reading Order tool 
(Advanced > Accessibility > TouchUp Reading Order...).  It is recom-
mended to add tags to the document before using the TouchUp Reading 
Order tool.

2. The mouse pointer will turn into a set of cross-hairs.  Click and drag a box 
around the content you wish to zone.  Draw the zoning region larger than 
the actual region of the content (in some cases, you may have to overlap 
into other content regions to zone correct content).



3. The content you have “zoned” will have a blue outline around the charac-
ters or words.

4. Choose the appropriate content type in the TouchUp Reading Order panel.

5. Save the document in order to retain the changes. Content that has been 
zoned and marked will appear as in a gray box with a number in the upper 
left corner.

The TouchUp Reading Order panel can also be used to reclassify content after 
performing the Add Tags to Document function.  Tables and images may be 
classified incorrectly and the TouchUp Reading Order panel allows to reset 
the content to the correct structure type.  More information about classifying 
images and tables is provided in the next section.

Images

Once a PDF document has been tagged, it is possible to add alternate text to 
relevant images.  Most often, the Add Tags to Document function will correctly 
identify images within the document and mark these as “Figures”.  The docu-
ment author can then insert the appropriate alternative text for the image in 
question.
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1. To add a text description to an image, enable the TouchUp Reading Order 
tool (Advanced > Accessibility > TouchUp Reading Order...).

2. If the image contains the text “Figure - No alternative text”, right-click on 
the image and choose Edit Alternate Text.

3. Add the appropriate alternative text content to the image and press OK.

4. Save the document in order to retain the changes.

If the image does not contain the text “Figure - No alternative text”, then it 
is necessary to zone the image and mark it as a “Figure” using the TouchUp 
Reading Order tool.  Please refer to the section Zoning and Marking Text for 
more information on adding content to the document structure.  After zoning 
and marking the image as a “Figure”, follow the instructions for adding alterna-
tive text.

Tables

There are two types of tables that may be used in documents - data tables and 
layout tables.  When authoring documents, particularly from word processing 
applications, it is not recommended to use layout tables to organize and visu-
ally arrange content.  If there is a need to create rich visual layouts, then the use 
of layout and design tools that support accessibility are necessary (e.g., Adobe 
InDesign).  Data tables, on the other hand, are a functional method to organize 
and relate various pieces of information into a coherent display.  Data tables 
may be used where appropriate and are an acceptable method to present con-
tent.

One challenge with data tables and accessibility is verifying how the informa-
tion will be presented to the actual user if assistive computer technology is 
being utilized.  For instance, it is fairly easy to determine the logical reading 
order of a document, but it is not as easy to determine if a data table contains all 



the relevant code to communicate the appropriate row and column information.  Testing 
with assistive computer technology is one method, however, this assumes that the assis-
tive computer technology supports the included tag information to accurately commu-
nicate the data table to the user.  With respect to PDF, the recommendation is to include 
the appropriate code information and test (when necessary) with the understanding that 
not all assistive computer technology will support the PDF data table content.

In order to specify row and column headers, as well as a table summary, it is necessary 
to begin with a tagged PDF document with the data table marked as “Table”.  It is pos-
sible that if tags are added using the “Add Tags to Document” function that tables may 
be marked as “Figure” or other text content.  Use the TouchUp Reading Order tool to 
zone and mark data table content as “Table” before proceeding below.

Row and Column Headers

Row and column headers, as well as their “scope” can be specified using the TouchUp 
Reading Order tool.  This would potentially aid assistive computer technology applica-
tions in speaking the relevant row or column information to an individual navigating 
the data table.

1.  To add row and column header information, enable the TouchUp Reading Order 
tool (Advanced > Accessibility > TouchUp Reading Order...).

2. Click on the number next to the “Table” label in the PDF document.

3. In the TouchUp Reading Order tool, choose the “Table Inspector” button

4. For each row header, right click in the actual table cell and choose “Table Cell 
Properties”

5. Set the “Type” as Header Cell and the “Scope” property as Row.

6. Press OK to return to the data table.

7. For each column headers, perform the same steps but set the “Scope” property as 
Column.

8. Repeat as necessary for the remainder of the row and column header cells.

After adding the relevant information to the data table, click outside of the table region 
on the page to return back to the TouchUp Reading Order tool interface.
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Table Summary

A table summary can be added that provides the user with a very brief overview 
of what information is to follow in the data table.  It is not necessary to repeat 
the actual data in the table summary; rather, use the table summary to give the 
user a preview of what information the table communicates.  The table sum-
mary is not viewable in the PDF document, but is designed to be spoken to an 
individual using assistive computer technology.

1. To add a table summary, enable the TouchUp Reading Order tool 
(Advanced > Accessibility > TouchUp Reading Order...).

2. With the data table marked as a “Table”, right-click anywhere in the data 
table.

3. Choose the option “Edit Table Summary”.

4. Add an appropriate summary for the table and press OK.

5. Save the document to retain the changes.  

The Table Inspector in Adobe Acrobat functions well for basic data tables that 
do not contain multiple row or column headers.  For data tables that contain 
multiple row and column headers, are visually complex, or contain numerous 
cells that span rows/columns, it may be necessary to utilize third-party PDF 
markup tools to fully support PDF accessibility (e.g., the CommonLook for 
PDF tool from NetCentric).



 Adobe LiveCycle Designer 8.2

Application
Adobe LiveCycle Designer (Windows platform only)
http://www.adobe.com/devnet/livecycle/

Introduction
Adobe LiveCycle Designer is a drag-and-drop form creation tool that allows 
authors to create interactive form elements using a layout and design interface.  
LiveCycle Designer comes bundled with Adobe Acrobat 9 Professional and 
is currrently only available for the Windows platform.  From an accessibility 
perspective, LiveCycle Designer provides form authors with the ability to des-
ignate content headings, add the appropriate information necessary to support 
assistive computer technologies, and control the logical reading order/tab order 
of the form.  One advantage to LiveCycle Designer is that the accessibility 
information can be added during form creation without requiring the author to 
use a separate application to add the necessary accessibility information.  This 
allows forms that require periodic updating to be changed without returning to 
the original form document, making the content changes, converting to PDF, 
and then adding the form fields again.

The default file type from LiveCycle Designer is PDF; saving the file in Live-
Cycle Designer automatically creates the PDF version.  The form fields created 
in LiveCycle Designer cannot be edited in Adobe Acrobat.  Forms created in 
Adobe Acrobat can be opened and edited in LiveCycle Designer.  Once a PDF 
form has been saved from LiveCycle Designer, the form information cannot be 
edited in Adobe Acrobat.

Accessibility Panel

The Accessibility panel allows form authors to add the appropriate accessibility 
information to document content and form fields in order to improve PDF form 
accessibility.  The Accessibility panel can be accessed by selecting Window 
from the menu bar and then choosing Accessibility (hotkey = Shift+F6).  The 
Accessibility panel will vary its editable regions depending on the text element 
or form field selected in the page layout window.

For most form fields, there is a Tool Tip option, Screen-Reader Precedence 
option and Custom Screen-Reader Text option that can be used in different 
combinations.  The Screen-Reader Precedence option and the Custom Screen-
Reader Text region can be used when you wish to specify custom information 
to individuals using screen-reader technology.  The current situation is that if 
accessibility information is entered into the Tool Tip region AND the Custom 
Screen-Reader Text region AND the Screen-Reader Precedence is set to Custom 
Text, only the information in the Custom Screen-Reader region will be used to 
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communicate with assistive computer technologies.  However, the text in the 
Custom Screen-Reader Text region will ALSO be shown visually on the PDF 
form when the user hovers the mouse in that specific form field, not the infor-
mation in the Tool Tip text region.

Screen-readers will currently check for accessibility content in the following 
order: Custom Text > Tool Tip > Form Caption > Form Name > None.  As soon 
as information is available, the screen-reader will communicate this informa-
tion to the user and stop checking for additional accessibility content.  Thus, 
by entering information into the Tool Tip field it is not necessary to adjust the 
Screen-Reader Precedence option for each input field.  To develop forms that 
are usable by all individuals, the recommendation is to add the appropriate 
accessibility information into the Tool Tip region with the understanding this 
will also be visually discernible on the PDF form.

Headings

Headings can be used to identify sections and provide structure to the document 
content.  The advantage of headings from an accessibility perspective is that 
some assistive computer technologies can identify headings in a document and 
allow the user to navigate from heading element to heading element.  This pro-
vides a mechanism to “jump” through the content without having to read each 
passage of text.

1. To add a heading role to text content, drag a text block to the page (this 
element is the letter “T” with a plus sign).

2. Add the appropriate text information into this text block

3. Choose Window from the menu bar, and then Accessibility.

4. Under the Accessibility tab, select the Role drop-down menu and choose 
the correct heading level.

Only set appropriate content as a heading.  For instance, a paragraph of text 
would not necessarily be a heading in a document, but the name of a section 
could be a heading.

Text Input Fields

Text input fields are perhaps the most common form field elements used on 
documents.  For text input fields, the accessibility information should include 
what information you want the user to enter into the form field.  Make sure 
to identify any specific instructions or relevant information for the user when 
adding the accessibility information.  For example, if the caption of the text 
input field is “First Name”, then the accessibility information could be “Enter 
First Name” or even “First Name”.



1. To add a text input field, drag the Text Field icon to the page (this icon has 
a pencil in it).

2. Add the appropriate caption information and format the field as needed.

3. Choose Window from the menu bar, and then Accessibility.

4. Under the Accessibility tab, enter the appropriate accessibility information 
in the Tool Tip region.

5. Leave the Screen-Reader Precedence option set to Custom Text (default).

Radio Buttons

Radio buttons are designed to give “either this or that” response such that the 
user is required to select only one of the available options.  Radio buttons are a 
bit different than other form fields in that they belong to an exclusion group.  In 
other words, all the radio buttons “belong” to the same grouping (this allows 
one button to be deselected if another button is selected).  If you wish for radio 
buttons to all be part of the same exclusion group, it is recommended to add all 
the radio buttons at the same time.  For instance, if a form was to have two radio 
buttons as part of the same group, do not add a radio button, then add a text 
field, and then add the second radio button.  This will cause the radio buttons 
to be part of two different exclusion groups (i.e., they will not be “grouped” 
together).

1. Drag a text block to the page (this element is the letter “T” with a plus 
sign).  This is the question for the radio button group.

2. Drag the appropriate number of radio buttons to the page.  A blue outline 
will surround all the radio buttons regardless of where they are placed on 
the page.

3. Enter the appropriate response to each radio button caption.

4. In the Binding Tab (in the Object panel), uncheck the box “Specify Item 
Values”.

5. Select the radio button exclusion group (a blue outline will surround all 
the radio buttons) and choose the Accessibility panel.

6. In the Tool Tip region, enter the question for the radio button group.  This 
should be the same text as specified in the text block.

The result will be that screen-readers will enter the radio button grouping and 
will read the question, the radio button caption, and the radio button status 
(checked or unchecked) each time the user moves to a new radio button.  For 
information on how to use specific item values, while maintaining support 
for screen-readers, please review the Help menu under Accessible forms for 
detailed instructions.
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Checkboxes

Checkboxes can be used to allow the user to select more than one option or 
to choose not to select any option.  Checkboxes are individual entities and so 
require accessibility information to be added for each checkbox (there is no 
exclusion group like radio buttons for checkbox fields).  Because checkboxes 
are there own “unique” element, it is necessary to combine the question and 
answer such that the user may choose the appropriate response.
For example, if the question is “What is your favorite ice cream flavor?”, then 
an appropriate accessibility response may be “Check if your favorite ice cream 
flavor is Rocky Road”.

1. Drag a text block to the page (this element is the letter “T” with a plus 
sign) as this is the question for the group of checkboxes.

2.  Drag the appropriate number of checkboxes to the page.

3.  Enter the appropriate response to each checkbox caption.

4. Select the Accessibility panel and in the Tool Tip region enter the appro-
priate accessibility response that combines the question with the answer.

Drop-Down List

The drop-down list option allows user to select from a list of options while min-
imizing space on the form.  While there are advantages to using a drop-down 
list, be cautious if the form is to be printed - users will not have access to all the 
form field selections

1. Drag the drop-down list icon to a location on the page

2. Enter the caption information.  Generally speaking, this would be the 
question.

3. In the Object panel, under the Field tab, add the appropriate list items for 
selection

4. Select the Accessibility panel and add the appropriate instructions.  This 
will be the information provided in the caption.

Tab Order

In LiveCycle Designer, the Tab Order does more than just specify how a user 
would navigate through a PDF form with the keyboard.  The Tab Order allows 
the form author to control the logical reading order of the document including 
all text regions and form input fields.  When setting the tab order in a LiveCycle 
Designer form, it is important to take note of the various text elements on the 
page and include those elements along with the form input fields in order to 
ensure a logical document reading order.



1. To establish a tab order, choose Window on the menu bar and Tab Order.

2. On the left side of the screen, click the Custom radio button to change the 
order of the elements.

3. Use the arrow buttons to move the desired elements higher or lower in the 
element hierarchy (you may also drag and drop an element to its appro-
priate position).

4. When you have completed ordering the document elements, close the 
panel or choose Window > Tab Order to complete the process.

In Adobe Acrobat, confirm the reading order by saving the document as a text 
file, using assistive computer technology, or using the Read Out Loud function 
on the PDF form.  If you find any problems with the reading order, return to the 
Adobe LiveCycle Designer interface and alter the reading order as necessary.
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Resources

Websites
Adobe Acrobat Accessibility Training Resources
http://www.adobe.com/enterprise/accessibility/training.html

Adobe Accessibility Resource Center
http://www.adobe.com/accessibility/

CommonLookTM Section 508 for Adobe Acrobat
http://www.net-centric.com/products/cl_s508_adobe.aspx

Creating forms using Adobe LiveCycle Designer 8
http://www.adobe.com/devnet/livecycle/articles/strategies_creating_forms_lc_
designer8.html

Designing LiveCycle Forms
http://www.adobe.com/devnet/livecycle/designing_forms.html

Facts and Opinions about PDF Accessibility
http://www.alistapart.com/articles/pdf_accessibility

Use of PDFs in Accessible Documents
http://wcagsamurai.org/errata/pdf.html

Books
Web Accessibility: Web Standards and Regulatory Compliance (Chapter 12: 
PDF Accessibility).  Thatcher, J., et al. ISBN-10: 1590596382, ISBN-13: 978-
1590596388.

Maximum Accessibility: Making Your Web Site More Usable for Everyone. 
Slatin, J., Rush, S. ISBN-10: 0201774224, ISBN-13: 978-0201774221.
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